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Introduction

Congratulations on your purchase of the Millennia
Media HV-316 Remote-Controllable Microphone
Preamplifier.

We will refer to both the HV-316/8 8-Channel
and HV-316 16-Channel as the HV-316 unless
there is an operational difference.

The HV-316 is the result of meticulous blind listening
tests on innumerable circuit topologies and E/M
designs. Your HV-316 is a finely tuned instrument
intended for critical professional applications — we
feel it offers the world's most sonically neutral
microphone preamplification.

Up to 16 HV-316s can be simultaneously controlled
plus an additional 16 HV-3Rs - a total of 384
channels on one system. A high-speed Ethernet
control interface makes this possible without any
significant system control latency, even if all 384
channels were to change parameters simultaneously.

Future Update: The MIDI control interface is
compatible with Avid’s Pro Tools® “PRE” remote
microphone preamplifier protocol. As defined by
Avid, up to 4 HV-316 (8 HV-316/8) units can be
simultaneously controlled with MIDI in Pro Tools.

FCC Notice Information for the User

This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against
harmful interference when the equipment is operated
in @ commercial environment. This equipment
generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance
with this instruction manual, may cause harmful
interference to radio communications. Operation of
this equipment in a residential area is likely to cause
harmful interference in which case the user will be
required to correct the interference at his or her own
expense.

Safety Precautions

For your safety and the safety of others, be sure to
read and understand all safety and operational
instructions before attempting to use the HV-316.

WARNING: The HV-316 internal circuitry carries
lethal voltages. Carefully observe all warnings,
precautions, and instructions on the HV-316 and as
described in the instructions supplied with the unit.
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Water, Moisture, and Spillage - Do not attempt
to use the HV-316 in, near, or around water or in
unusually moist environments, such as near a sink or
swimming pool. Prevent liquids or any other
materials or objects from spilling or falling into the
HV-316 unit.

Heat & Ventilation - Be sure to allow adequate
ventilation on both sides of the HV-316 and avoid
blocking the fan air intake and exit vents.

Power Sources & Power Cord Protection — The
HV-316 Power Supply should be connected to a
power source only of the type described in the
operating instructions or as marked on the Power
Supply. Route the power cord so that it is not likely
to be walked on or pinched by having objects placed
on it. Pay particular attention to plugs, receptacles,
and the point where the AC power cord exits the
HV-316.

Grounding - For your safety, it is extremely
important that the grounding pin of the 3-wire power
cable (included with 110 Volt units) be inserted into
a grounding type 3-pin power outlet. If you are
unable to insert the plug into an existing outlet,
contact an electrician to install a properly grounded
3-pin power outlet, preferably that with OFI / GFI
protection, if available.

Damage Requiring Service - This unit should be
repaired or serviced by qualified personnel
whenever:
e The AC power cord has been damaged, or
e Objects have fallen or liquid has spilled into
any HV-316 unit, or
e  The unit does not function properly or
exhibits a marked change in performance,
or
e  The unit has been abused, dropped, or
damaged, or
e The unit has been exposed to rain or
moisture.

Servicing — Lethal voltages are found inside the
HV-316 chassis. The user should not attempt to
repair or service this unit. All servicing and/or repairs
should be referred to Millennia.

If, after reading all instructions, precautions, and
warnings, you have remaining questions, please
contact Millennia directly before attempting to use
your HV-316.

The HV-316 enclosure measures approximately 17"
wide x 1.75” high x 16" deep and is designed for
mounting into a standard 1U, 19” equipment rack. If
the HV-316 is mounted in a road case or other rack
which is prone to strong vibration or shock, it is
highly recommended that the rear of the HV-316 be
supported or otherwise reinforced to withstand such
conditions.

HV-316 is designed on a common ground topology.
For high quality operation, and for your own safety
and the safety of others, do not defeat the power
cord earth grounding pin.

Millennia Media HV-316



HV-316 Front-End Protection - Millennia Music &
Media Systems enjoys a reputation for what many
top engineers and producers call the world’s most
musically accurate and dynamically uniform
microphone preamplifier — the HV-3. But this
thoroughbred design is not achieved without certain
operating criteria. To maintain top performance and
protect the HV-316’s sensitive HV-3 front-end, it is
advised that you do not insert or extract
microphones with phantom power on. Get in the
habit of waiting about ten seconds for the phantom
power to fully “ramp down” before inserting or
removing a microphone. This is good advice for
protecting your microphone investments, as well.

Any changes or modifications not expressly approved
by MILLENNIA MEDIA, FPC (Millennia) could void
your authority to operate this equipment under the
EC, ICAN, or FCC rules.

Copyright - You acknowledge that no title to the
intellectual property in the HV-316 is transferred to
you.

Inspection - Inspect packing box(es), HV-316, and
cable(s) for damage, unusual marks, or shortages. It
is your responsibility to report damage, shortage, or
mis-shipments in a timely manner. Millennia and/or
its dealers will not be responsible for claims arising
from damage in shipping, nor will claims for shortage
or mis-shipments be honored, more than 10 days
after ship date.

Read this manual carefully and completely before
attempting to use the HV-316. Improper operation
could result in damage to product. It is the user’s
responsibility to understand the safe use and
operation of this device.

The shipping box of the HV-316 system will include:

e  Quick Start Guide
e UL approved power cord (110 V countries only
except Japan)

The material contained in this manual consists of
information that is property of Millennia and is
intended solely for use by the purchasers of the
equipment described in this manual. Without express
written permission, Millennia prohibits the duplication
of any portion of this manual or the use thereof for
any purpose other than the operation and/or
maintenance of the equipment described in this
manual. This manual may not be duplicated in whole
or in part without the written consent of Millennia.

Millennia Media HV-316

The HV-316 serial number is located on the rear and
bottom of each unit. We suggest that you record the
serial number in the space provided below. Refer to
it whenever you call an authorized Millennia repair
facility or the manufacturer. Make sure that you
register your Millennia product(s) online.

Features and specifications subject to change
without notice.

© 2023 - Millennia Media, SPC., all rights reserved

Serial Number

Purchase Date

Where Purchased
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Front Panel Functions

The 3/8" thick hand-machined aluminum front panel
consists of 48 LED status indicators and a two-digit
numerical display.

FElogic software is required to operate the HV-316.
The most current version can be downloaded at
£logic Weblink. Scroll down to the Downloads
section. It requires a computer running MS Windows
10 or higher.

Unit ID Display - Indicates unit number assigned
to preamp.

Rear Panel Functions

AC Power - IEC power inlet, 80-264 VAC 47-63 Hz

MIDI Connection - Allows remote control of the
HV-316 using MIDI protocol. Use with Yamaha
break-out cable ZP893500

Ethernet — Dante audio networking and /Elogic
control. Alogic is only available on the Network
Primary connector

Network Reset - Restore to factory default
settings. Static IP address 192.168.1.221, Netmask
255.255.255.0

HV316 must be powered off.

- -

Power Indicator - Decimal point indicates unit
has power. It takes about 20 seconds after
power up before the Unit ID Display comes on.

Input Level & Phantom Power Indicator -
Green indicates levels -46 dBFS and higher. Red
indicates 0 dBFS. Amber indicates phantom
power is on.

Auxiliary Power - Indicates 12V auxiliary
(redundant) power source is powering unit.

Power Switch - Turns the unit on and off.

LLENNIA MEDIA FIC

— Analog Outputs 1-8
“MIUMEDIA COM e ~3 #":5&2"‘"}_
;J’g‘tjﬁ%"mu%m == = = ==y
T T e — — 1 |
= - ———
o

12 Volt Redundant (Auxiliary) Power — 12
Volt Redundant (Auxiliary) Power — Connect only
Millennia approved optional backup power
supply here (Meanwell GST120A12-R7B).

Use of 12V battery requires external 8A
inline fuse. Do not connect non-fused
battery.

Unit ID Selector — Address Select Rotary
Switch sets Unit ID. The front panel numeric
display changes to reflect the value selected
here. If connected to a network, the power
needs to be cycled for the change to take effect
in /Elogic.

Address | 1 2 3 4 5 6 7 8
Unit ID 1 2 3 4

Address | 9 A B C D E F 0
Unit ID 9 10 11 12 13 14 15 16

Insert a small non-metallic object into the reset
opening on the read of the unit. You should feel a
slight click when the reset button is depressed.

(6]
o]

Turn on the unit while continuing to hold the reset
button.

When the unit processor has reset it will display “00”
in the Unit ID display on the front of the unit.

Release the reset switch on the rear. The unit will
continue to boot.

When the ID Display switches to the selected Unit
ID, the device is ready to use. It will have the factory
profile and will be set to Static IP address
192.168.1.221, Netmask 255.255.255.0.

Page 5 of 24 rev 032723

Mic Inputs - Eight channels of
microphone-level input wired in the AES59/
Tascam format.

Analog Output Option - DB25s wired in the
AES59/Tascam format for analog outputs. This
option must be added at the factory.

Reserved DB25 - for future options.

Millennia Media HV-316
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Getting Started

Millennia’s Alogic software (Windows 10 only, other
versions may work but are not supported) is used to
control the unit and should be installed on your
computer before connecting the HV-316 to the
network. It can be downloaded at Alogic Software
Scroll down to the Downloads section.

Installing the AElogic Software - Turn off virus
protection software before installing. Remember to
turn the protection software on when finished.

You need to allow Alogic all permissions to access
your network. Failing to do so will prevent the
software from seeing the Millennia Preamps
connected.

If you are using Wi-Fi®, turn it off and use the wired
Ethernet connection to be sure all the permissions
are applied to it so you connect the HV-316 directly
to your computer to initialize its IP address.

Extract the zipped files and Open

Millennia_AELogic_Installer.msi

The following screen will appear.

Click on more info.

Click on Run Anywa

Millennia Media HV-316

Click on Next

42 Millennia AELogic Setup - X

Welcome to the Millennia AELogic Setup
Wizard

The Setup Wizard wil install the Millennia AELogic Software
Controller for the HY~316 and HV-3R Remote Controlable Mic
Preamps on your computer.

Millennia
Music & Media Systems

Check Accept and click on Next

12 Millennia AELogic Setup - x
End-User License Agreement
Please read the folowing license agreement carefully

END USER LICENSE AGREEMENT (EULA)
Millennia Media, S5PC

6411 Capitol Ave.

Diamond Springs, CA 95618 USA

1. GENERAL.

1.1 This EULA explains the conditions (“Terms”) between you (“Licensee”,
“User” “You", etc.} and Millennia Mediz, SPC, and its affiliates (*Millennia”,
“we”, etc.) for the use of Millennia’s products, including any ()

infarmation data dncuments imases or internet-hased media and (bl 2

[AT accept the terms in the License Agreement

Pt | | Back | nNext | | cancel

12 Millennia AELogic Setup - x
Destination Folder
Cick Next to nstall to the default folder or dick Change to choose another.

Instal Milernia AELogic to:

|c \Program Files (x86)WMilennia AELogic|

= e

Click on Install

42 Millennia AELogic Setup — x

Ready to install Millennia AELogic M

Cick Instal to begin the installation. Cick Back to review or change any of your
installation settings. Clck Cancel to exit the wizard,

sak [ sl | | cancel

Click on Yes

D:\Downloads\AELogic 072120\7-21-20
8-94-0\Millennia_HV3Series_Installer.msi

Publisher: Unknown
File origin: Hard drive on this computer

Show more details

Select the location to save the file and click Next
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Click on Finish

Completed the Millennia AELogic Setup
Wizard

lick the Finish button to exit the Setup Wizard.

Millennia
Music & Media Systems

= el

Select Private Network and Click on Allow Access

P Windows Security Alert 5 ‘

G
app

ws Defender Firewall has blocked some features of this

Windows Defender Frewall has blocked some features of milennia-hv 3series. exe on all public
ancdprvate networks
M Mame: frilervia b eries. exe]
Publisher: Unknown
Path: C:\program files (x86) yilennia aelogic ynilennia
hv3series.exe
Allow exe to
[Prvate netwarks, such as my hame or work network
O ‘such as those n airport
because these networks often have little or no security)
.20 200 trouch a frewal
& tow access Cancel

Setting Unit ID(s) and IP Addresses — Each
HV-316 needs to be set to its own unique Unit ID
and IP address. If units have the same ID or IP
addresses there will be a conflict and the system will
not work properly.

You can not use the same IP address for Alogic
and Dante. Use Dante Controller for setting the IP
address for the audio connection.

Set the Unit ID using the Address Select Rotary
Switch on the rear panel before connecting the HV-
316 to the computer or network.

The table below is a suggested addressing scheme.

IP Address Unit ID
192.168.1.200 Host Computer
192.168.1.221 HV-316 ID 01
192.168.1.222 HV-316 ID 02
192.168.1.223 HV-316 ID 03
192.168.1.2nn HV-316 ID nn

Be sure the computer’s wired Ethernet connection is
set to IP address 192.168.1.200.

There are many ways to do this and Microsoft
occasionally changes the setup menus. As of this
writing, this method allows quick IP address setting.

Setting the Host Computer’s IP Address
(Windows 10 and 11)
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1. Press the Windows key and the R key at
the same time to open the Run box.
Type ncpa.cpl and press Enter to access
Network Connections immediately.
Run X

—, Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you

Open: >
Cancel Browse.

2. Double click on the HV-316 Ethernet Connection

to open its properties.

."‘ " Ethernet 2
— . Unidentified netwaork
i

“ Realtek USB GbE Family Contr...

i

3. Double Click on Internet Protocol Version 4

(TCL/IPv4)

[ Ethernet 2 Properties X
Networking  Sharing

Connect using:
3P Realtek USB GbE Family Controller #2

This connection uses the following tems:

i) B Client for Microsoft Netwarks A
) ? File and Printer Sharing for Microsoft Networks

W %8QoS Packet Scheduler

2R rtemet Protocol Version 4 (TCP/IPv4) |

[J . Microsoft Network Adapter Multiplexor Protocol

W 4 Microsoft LLDP Protocol Driver

W 4 Intemet Protocol Version 6 (TCP/IPv6) v
< >

Install... Uninstal Properties
Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

0K Cancel

Nouwu s

Select “Use the following IP addresses”.
Enter 192.168.1.200 in IP Address.
Enter 255.255.255.0 in Subnet mask.
Click OK and continue to exit Network
Connections.

Internet Protocol Version 4 (TCP/IPv4) Properties X
General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@ Use the folowing IP address:

1P address: 192.168. 1 .200 |
Subnet mask: L 255.255.255. 0 |
Default gateway: [

(®) Use the following DNS server addresses:
Preferred DNS server:

Alternate DNS server:

[[] validate settings upon exit

8.

9.

Connect the Host Computer directly to the
HV-316’s Ethernet Port
Run the Alogic Software.

Millennia Media HV-316
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If you have everything set correctly when Alogic
opens, the icon of the HV-316’s Unit ID in the Unit
Status window will turn green. Double click on it to
open the Unit Status dialog box.

Set the HV-316 IP address and click OK

Unit Status

STATUS OF UNIT 12 (HV-316)

Functional Status: FUNCTIONING NORMALLY

Temperature: 26.0 degrees C
MAC Address: C8:0F:34:E2:D4:29
Firmware Version: 1.9.0-01-0.3.1
Output Format: DANTE

IP Address:
" set Automatically

* setManually

1P Address: 192.168.1.221
Subnet Mask: | 255,255,255.0

Split Gain Offset: o0dB

[ Prev ] [Cancel‘ [OK| [ Mext ]
\

You will lose connection if you select an IP

Address other than 192.168.1.xxx and will need
to change your computer’s IP Address to access the
network that you have chosen to use your HV-316s.

Dynamic Host Configuration Protocol (DHCP) is
also an option for “IP Address”, but we don't
recommend using it unless you are familiar with
networking and have the proper network hardware
that supports it.

Ethernet and MIDI control cannot be used
simultaneously - only one remote control protocol
can be used in an HV-316 network.

Running more than one instance of ZAlogic on

the same network can cause gain errors and other
issues.

Millennia Media HV-316

Default Settings - The HV-316 is shipped to
startup with the default settings:

All functions turned off (POL, PAD, 48V,
MUTE, SPLIT, SAFE, RBN and HPF).

IP Address set to 192.168.1.221
Netmask 255.255.255.0

UnitID 1
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Scene Window Unit Status Window

M AELogic - Sound Checkmsf / - o X
Files Edit _ Setup Help AEL0g

Active Scene: 000

Sound Check initial

000 Blank Scene » 2 [z ] [ ] [« ] [s ] [s

002 Band Intro 7 ] [0 co—m] (s ] [10 | [11 | 12 |
003 Hard open

004 Soft open O&] : [-VJQ‘E] [14 =] [15 =] [16 c==m ] [17 | (1o > |

005 Ballad no drums

gbhbihuiy

Control Section

FElogic Operation unit to Remote mode so the software can recognize
the HV-3R.

Millennia’s Alogic remote control software is
intuitive. What follows is an in-depth description of
its available functions. Refer to Appendix for a list of
keyboard shortcuts.

Purple Icon - “Unit ID Is Offline”. A unit was
previously connected to the network and set to this
Unit ID but is missing from the network. It was
either turned off or the Ethernet was disconnected or
both.

Unit Status Window - The example screen above
shows a Unit Status window in which seven HV-316
units (112 channels) are connected to the remote
network. The Unit Status window displays an icon of
each HV-316 unit on the network. The status of each
HV-316 is represented by its icon’s color code, as
follows:

Blue Icon - The Redundant Power Supply is
powering the unit and the internal power supply is
offline due to either failing or losing AC mains power.

Gray Icon - “Unit ID Is Inactive”. No unit is
connected to the network and set to this Unit ID.

Red Icon - "Unit ID Has a Conflict with Another
Unit”. If two or more HV-316s share the same Unit
ID number or IP address, their icons will turn red
and will show identical IDs or IP addresses until the
conflict is resolved.

Unit ID Conflict - If more than one unit has the
same ID number this warning will
appear. You must correct the

problem before you can continue.

Setting a Unit ID or IP address must be done locally
on each HV-316. Other errors could also cause a red
icon, such as over-temperature, power supply out of
range, other networking errors, etc.

Unit Status Dialog — Double left mouse click on
any icon brings up that unit’s Unit Status dialog box
displaying the following information:

Green Icon - “Functioning Normally”. Remote unit ; gg\l,t S‘gﬁfttg‘ﬁ”(ﬂ'\%m TS o U 12 0 1)
functioning normally. 3. 24v Monitor (HV-3R) e s

4.  5v Monitor (HV-3R)
Flashing Green Icon - HV-3R only. “Functioning 5. 3.3v Monitor (HV-3R)
Normally, Local Mode”. Remote unit is functioning 6. Temperature
normally but is in the local mode. 7. MAC Address "

8. Firmware Version J—
HV-3R only: if the unit is in Local mode when £logic E1)0 %”ZZLétrerosrmat ==
is started, it won't appear. Be sure to change the 11. Split Gain Offset

Page 9 of 24 rev 032723 Millennia Media HV-316
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M AELogic - Sound Checkmsf
Files  Edit  Setup  Help

Active Scene: 000 Unit Status

Blank Scene

001 Sound Check Inttial

002 Band Intro l’
004 S oo Bl (=) [ (s (o) (i) (e
005 Ballad no drums nt

] [o o] (o ] [10 | 11 camm | [ 12 e |

Overview

oL Pan. o ot Pan.
v wne e e e e e e e e e v we s v e

spuTaare shuTsart seuTart seumsare

Overview - This is the default view. It expands
the channel control area to show multiple units.
Virtual switches are replaced by small virtual
LEDs. Link switch is replaced by link group
number only. Other attributes are shrunk to fit.
All functions remain accessible and adjustable
on the Overview Screen.

1 2 3

Enter the desired title for Unit 1

JUNIT 1 - Hvate_T6

Notes:

Above is a screen-shot of the OVERVIEW.

Control Section

[ Prev | (oK |[cancel] [ next ]

S WE_ | WE_ WS

0
1
3
6
8
10
13
16
19
2
26
30
35
41
a8
55
8
86

0
1
3
6
8
10
13
16
19
2
26
-30
35
a1
a8
56
68
8

Basic Navigation & Behavior
Mmoo
KN EE K KN

The channel controls are grouped into their
respective HV-316 8-channel Units. The screen
shot on the previous page shows units #1
through #7. You can left-click on any unit icon
shown in the Unit Status window to immediately
bring that unit’s channel controls into the main Control Layout
screen.

H]H
-fA8
184
-8

o]
=
>

The main control section, starting from the top
down, graphically represents these features:

Note the scroll bar at the bottom of the screen.
It allows the user to quickly scroll to any unit in
the network. You can also move the Control
Section by using the Left and Right arrow keys
on the keyboard. Pressing an arrow key once
corresponds to scrolling in that direction by one
channel strip.

Unit Name

Channel Number

Polarity Invert Button

Pad (20 dB Attenuator) Select Button
48V Phantom Select Button
Mute Select Button

Gain fader

Plasma-type Metering
Channel Gain numeric

10. Split Gain Mode

11. Safe

12. Ribbon

13. High Pass Filter

14. Link Assignment

15. Scribble Strip

HV-3R only: Alogic is always the master control
when the unit is in Remote Mode. Any changes
made to the unit’s front panel in Local mode will
be overwritten when the HV-3R is put back into
Remote Mode.

CONOUTEWN R
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Unit Naming and Unit Name Dialog Box
(right-click on unit name) - Each Unit's name is
shown above its eight-channel grouping. The default
name for each unit is its Unit ID. For instance, “UNIT
1" corresponds with channels 1-16 and “UNIT 2”
corresponds with channels 17-32. Right-clicking on
the Unit Name area opens the Unit Name dialog
(shown above) which allows textual naming of that
unit. A section for notes is also available to include
any supplementary information about the unit.

In order to name multiple units quickly, the “Prev”
and “Next” buttons allow the user to scroll through
units without closing the dialog box. If a unit has
been re-named from the default, the new Unit Name
will now be displayed in the Unit Name box. The
Naming Window can also be accessed from the
pull-down menus (Edit>Unit Naming).

Meter Preferences

Veter Scae
OcBU |22 ]dBU (Max Level)

@dBFS [18 v |dBFS (Reference Level)
Channel Name Mieter Display Pezk Hold Time  Red Zone
() Peak Only O 35ec [22 %48
Enler the desired fle for Charnel 6 @ VU Oy @10Sec  Display Ste
Qreakand VU O infinte @ Plasma
OQPeakoverVl - QO
Nots
oK

Channel Strip Display and Functions

Channel Number - Channel numbers appear at the
top of the channel strip.

The preamp (HV-316) with Unit ID 1 will be assigned
channels 1-16. Unit ID 2 will be assigned channels
17-32 etc. The HV-316/8 and HV-3R are assigned 8
channels. Each HV-316 8-ch group is assigned “A” or
\\Bll.

POLarity Flip — Inverts channel audio output polarity
(180 degrees). The channel’s output waveform
becomes a mirror of the input signal. This is not a
“phase adjustment” as the output signal does not
shift in time relative to the input signal. Button
illuminates green.

PAD - Attenuates channel output by 20 dB (14 dB
HV-3R). The gain setting reflects the change.
Button illuminates green.

48V - Applies 48-volt phantom power to the
respective mic input channel. Phantom power is
applied equally to both pin 2 and pin 3 of that
channel’s mic input. Button illuminates yellow. You
must disable RBN before 48V can be enabled.

Caution - do not insert or extract a mic with
the phantom power on. It can damage the
microphone and/or the preamp input

MUTE - Mutes channel output. When channel is

muted, the meter will continue to operate allowing
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the user to view audio activity on that channel
without passing live audio. Mute parameter is
linkable. Button illuminates red.

Channel Gain Faders/Gain Display - A traditional
looking “mixer fader” that adjusts preamp channel
gain. A text box below the fader indicates the actual
channel gain setting in decibels.

HV-316 gain range is 1 dB to 64 dB (HV-3R gain
range is 8 dB to 69 dB with 80 dB optional). Gain is
segmented in 1 dB steps. The Up and Down
keyboard arrow keys can also be used to adjust the
channel gain in 1dB steps.

Meter Preferences
7 -

Meter Scale
C dBU |22

v | dBU (Max Level)
¢ dBFS [-18  +| dBFS (Reference Level)

Peak Hold Time
¢ 3Sec
" 10 Sec
" Infintte
C Off

Cancel

Meter Preferences Dialog - The Meter Preferences
dialog box provides for customization of meter
display and functions.

You can select Meter Scale as dBu (usually for an
analog system) or dBFS, typically for digital systems.

Peak Hold Time affects the numerical level
indicator above the meter and the floating line over
it.

SPLIT - Future update: For the HV-316/8 and HV-
316 only. Provides two Dante outputs per channel,
this turns on the split's gain compensation to provide
an inverted (constant) level (within +/- 12dB) of the
channel. Typically used to split signals between FOH
console and stage monitor console.

SAFE - The channel is not modified when a new
scene is loaded. All settings remain as they
currently are.

RBN - Turns off the 48V phantom power and DC-
couples the mic to the gain stage. Use with any
Ribbon or Dynamic mic (like an SM-57). A mic
requiring phantom power will not work in this mode.
You must disable 48V before RBN can be enabled.

HPF “3/80 - High Pass Filter, when engaged, is -3dB
down at 80Hz, with 6 dB per octave roll off.

Millennia Media HV-316



Link Assignment - The Link parameter provides a
Gain and Mute linking utility. Linking applies to Gain
and Mute parameters only; no other parameters are
linkable.

The LINK button links and unlinks a channel from a
selected “link group”. There are ten selectable link
groups that can be chosen from the drop-down box
next to the LINK button or the Link Matrix. When a
link group is chosen, the LINK button is
automatically selected and illuminates red. One link
group can be assigned per channel. If no link group
is selected, a depressed LINK switch will effectively
do nothing.

Linked Gain - Linked Gain faders move together
maintaining the same distance they had when first
linked together. Once one fader reaches the upper or
lower extreme, the other faders in the same link
group stop moving in that direction.

Linked Gains can be trimmed by holding down the
Alt key while using the left mouse button. When the

Millennia Media HV-316

Alt key is released, the channel reverts to linked
mode.

Linked Mute - Linked Mute parameters will turn on
and off together unless “Mute linked channels” is
unchecked in the Preferences dialog box (Setup>
Preferences>"Mute linked channels”). If this box is
unchecked, the mute parameters will act
independently just like the other parameters.

Scribble Strip - (right-click on scribble strip)

A text box in which channels can be named and
notes can be written and stored. See the screenshot
on the previous page.

To name multiple channels quickly, “Prev” and
“Next” buttons allow the user to scroll through
channels without closing the dialog box. If a channel
has been re-named from the default, the new
Channel Name will now be displayed in the Unit
Name box. The Naming Window can also be
accessed from the pull-down menus (Edit>Channel
Naming).
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Link Matrix

Link Group Name

Enter the desired title for Link Group 3

Motes:

[(Prev| [ OK |[Cancc||

[Next > |

L

Link Matrix

N

-
Unit ID->| 1: Main Unit 2: UNIT 2 3: UNIT 3|
Cramels> 5 [ & AAAEABEREREEREAE
Link GI’DLID GI’DLID Title (=0 B~ (= = = =N L= B L0 B D= E—0 L0 E= E= =0 =]
01], Choir Stereo Pair, L ] q Channel Name
02]|Overhead Stereo p.4
03 a1t b
/ Enter the desired title for Channel &
04 \ 4
05 [Chair Mid
D6 \
= Maotes:
07 ||Rhythm Section &\
08 IF
09
10 \
P
@] [(Prev| [ 0K |[Cance|| [Next)|

o
-
-

Link Group Members

-
Link Group 1

Chaoir Stereo Pair
005 Choir Left
007 Choir Right

The Link Matrix dialog box provides for easier linking
and unlinking of channels and can be accessed via

shortcut ctrl-L or from the pull-down menus

(Edit>Link).

¢ Name a Link Group by right clicking a Link

Group number.

e See the members of a group by double clicking

the group’s name.

e Right click a link to bring up the channel naming

dialog box.
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Rename Scene

Enter a new name for the 'Prologue’ scene

Prologue

Notes:

Active Scene: 000

Blank Scene

\ 000 Blank Stene
« 001 Prologues

002 Jet Song

003 Something's Coming
(004 Dance at the Gym
005 Meeting Scene

S =

Enter Scene Name

-
Erter a name for the new scene

Notes

Scene Window

The Scene Window is found in the upper left corner
of the screen. A Scene remembers and recalls all
parameters of the current software environment
(gains, mutes, links, etc.). Scenes are used for
applications such as concerts or stage plays in which
new acts or set changes require different microphone
gains, mutes, links, metering, etc.

There are a few physical aspects to the scene
window worth noting before creating new scenes and
projects:

“Active Scene: ###" - The active scene number
displays the number of the scene that is currently
active.

Scene Name Display - Just below the active scene
number is a text display that defaults to “Blank
Scene.” This area displays the user designated name
of the currently active scene.

000 Blank Scene” — The default scene that is
automatically opened when the Alogic is first loaded
or when a Project, New or Saved, is opened. The
Blank Scene is to be used as a null starting point.
Selecting scene 000 will force all parameters of all
networked units to their “off” or “lowest” settings.
This default scene cannot be overwritten.

The Scene List - Scenes are arranged sequentially
within the Scene Window (000, 001, 002, etc.). The
Scene List is a scrollable list of all Scenes within the
Scene Window. Left-clicking a Scene Number/Name
will highlight it. No system functions will change until
the Recall button is clicked or until the desired scene
is double-clicked.

Millennia Media HV-316

Project and Scene Management

Creating a Project - Before anything (new scenes,
changes to scenes, etc.) can be saved, a project
itself must be created by doing a Save. Use
File>Save to name the Project and find a location to
save it. File>Save (ctrl-S) will save any updates or
changes to the project unless a new name is desired
(use File>Save As (shift+ctrl S)).

Scene Window - Underneath the Scene Window
there are four buttons “Recall”, “"New"”, “Delete”,
and “Lock.” The functions of these buttons are
explained below.

Safety Prompts - In order to exercise caution when
using the Scene Window Functions, safety prompts
are available in case buttons are pressed
accidentally. Safety prompts can be enabled for:

. New Scene

e Recall Scene

e Scene Delete

e Scene Re-Ordering

To turn safety prompts on and off go to
“Edit>Preferences” in the pull-down menus. The
section labeled “Scene Prompts” will have check
boxes for the four choices.

Creating New Scenes — Scenes are created by
using the “"New"” button below the scene window.
Once this button is pressed the “Enter Scene Name”
dialog box appears.

The scene name can be entered in the upper text
box and a section for Notes is also available to
include any supplementary information about the
scene. Once the scene is named it will be appended
to the Scene Window (next available scene number).

A newly created scene will assume all parameters
and settings of the active scene. Creating or naming
a scene does not make it active. Only Recall or
double-clicking can activate a scene.

Renaming Scenes - Once scenes are created, they
can be renamed by right-clicking on them. A dialog
box labeled “Rename Scene” will appear with the
same choices as the “Enter Scene Name” dialog box.

Reordering Scenes — Scenes are moved by
left-clicking and dragging them to the desired
location. Once a scene is moved, /Alogic will
automatically update the numbers in front of each
scene name.

Recalling Scenes - Scenes can be recalled two
different ways:

1. Highlight the desired scene and click the “Recall”
button.
2. Double click the scene name.

The scene’s parameters will be transmitted to all
of the units on the network.

page 14 of 24



- -

Scenes are not saved until you save the
project. (see Saving Scene Changes below for
information on how to save a scene)

Deleting Scenes — Scenes can also be deleted two
different ways: either highlighting the desired scene
and pressing the “Delete” button or highlighting it
and pressing the delete key on the keyboard.

Be careful when deleting scenes as the “Undo”
function does not work on deleted scenes.

When a scene is deleted, higher scene numbers will
automatically decrement. If an attempt to delete the
currently Active Scene is made, a prompt will pop up
explaining that it is active and cannot be deleted.

Locking Scene Window Functions — Sometimes it
may be necessary to disable the functions of the
Scene Window. The “Lock” button serves this
purpose. When the button is engaged, the other
three functions will turn dark grey and will no longer
be functional. Parameters in the Control Section
(faders, Links, function buttons, etc.) will still be
functional.

Appending and Saving Scenes - Whenever a
change is made to any parameter or function, an
asterisk (*) will appear next to the active scene in
the Scene Window (with the exception of the Blank
Scene). The asterisk will remain visible until the
Project is saved. The asterisk indicates a “dirty
event” - meaning that changes have been made
since the last Project save.

Saving Scene Changes - All Scenes shown in the
Scene Window are saved each time the Project is
saved (File>Save OR ctrl-S). Any changes to a
Scene (a “dirty event”) will be lost if the Project is
not saved before recalling another Project or if the
Project is not saved before exiting the GUI.

Loss of Power - If the HV-316 loses power or
FAELogic crashes it will come back online with the
parameters set the same as when it went off except
parameters Link, Safe and Split will be off.
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Setup Menu

Setup Help
Diagnostics >
Soft Reset...
Restart Program...

IP Address...
Unit |dentity Check... Ctrl+l
System Status...

Diagnostics - Check the IP Address, Flash the
display and shows the IP addresses and state of all
connected units

Setup System Status - shows the IP address and
state of all connected units

System Status

Unit 5 IP Address: 192.168.1.221 ACTIVE
Unit 9 IP Address: 192.168.1.225 ACTIVE

Soft Reset - Allows you to select a unit and reset it
to a state where all buttons are off and channel gain
is set to minimum.

Restart Program - Restarts ALogic

Millennia Media HV-316



Avid PRE Emulation for Using with Pro Tools

You can control your HV-316 with Pro Tools because
it uses the same MIDI control set as the Avid PRE.
Please refer to the Avid PRE manual on the Avid
website to learn how to set it up with Pro Tools.

Setting MIDI Channels

The MIDI channels of the HV-316 are determined by
its Unit ID. The HV-316 is equivalent to two Avid
PREs so it appears as its unit ID and its unit ID +1
(Unit ID on the HV-316/8)

Don’t choose an ID greater than 15 (16 on an HV-
316/8)

The exceptions to the PRE controls are:
Gains <8dB

Gains >64dB

Insert - not available

Mic Type - not available

Source Impedance - not available

Pad is 20dB, not 18dB

The gain maps in the following manner:

Pro Tools dB HV316 dB

0 1

3 1

6 1

9 1

12 1

15 15
18 18
21 21
24 24
27 27
30 30
33 33
36 36
39 39
42 42
45 45
48 48
51 51
54 54
57 57
60 60
63 63
66 64
69 64
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Yamaha R-Remote Compatibility

Gain, 48V and High Pass Filter (HPF) can be
controlled using Yamaha’s R-Remote software (web
link as of January 7, 2023).

All of the HV-316's other parameters and network
settings remain at the values last set by Alogic so be
sure everything is set the way you want them before
you instantiate R-Remote.

If your HV-316 serial number is below 240,
' it will need a firmware update. Please
contact Millennia for the update.

The HV-316 connects to R-Remote software via
ethernet using the Yamaha SCP protocol.

Once a connection has been made to the R-Remote
software, the HV-316 will ignore changes made with
FElogic until the unit is restarted without the R-
Remote software present on the network.

It can be controlled by multiple instances of R-
Remote software. Changes made on one instance will
propagate to the other instances.

R-Remote software maps as follows:
e 48V on or off.
. HPF on or off.
e Gain as shown in the table below

R-Remote | HV316 dB

-6 1

-5 1

-4 1

-3 1

-2 1

-1 1

0 1

1 1

2 2

3 3
One to One from 1 to 64

63 63

64 64

65 64

66 64
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® RRemote - X
File Tool About

HV316-05

#1
BLANK

#5
Tio1608-D

#h
BLANK

e The HV-316 will appear as a Tio1608-D in the
side-bar.

The unit-name will be set to HV316-[ID].
System and Sync lights will be fixed to green.
+48V Master will be always on.

No controls will appear for Polarity, Pad, Ribbon,
or Mute

Millennia Media HV-316


https://usa.yamaha.com/products/proaudio/software/r_remote/index.html

MADI Option

XMT RCV

=

_Millennia M

& Dante Controller - Metwork View
File Devices View Help
O & @ & & S-S @

Routing Device Info  Clock Status  Network Status  Events

-

Device Sync Mute Clock Domain
Name Source Status
HV316-16-1fc438  [] Dante N/A
RO-LAB-PC (] Dante NfA
teerok-Main ™ Dante NfA

TylersTechBench (] Dante M/

Initial Setup - The MADI card is a factory-
installed option enabling the HV-316 to function
on a MADI network. You’ll need to use Dante
Controller to adjust clock parameters.

Sample Rate - If you are using a sample rate
other than 48K, use Dante Controller’s device
set up window to change it. The sample rate
must match the MADI network’s.

https://dev.audinate.com/GA/dante-
controller/userguide/webhelp/content/device co

nfig tab.htm

Sync to External - The HV-316 receives the
MADI clock through its Dante card. The HV-316
should already be set to sync external. If not,
change it.

Here’s a link to Audinate’s documentation on
how to use Dante Controller’s Clock Status
window to do this:

https://dev.audinate.com/GA/dante-
controller/userguide/webhelp/content/clock syn
chronization.htm

Dante with MADI - If you want to use the
Dante outputs simultaneously, Dante network
parameters need to be changed using Dante
controller.

Use Dante Controller to set the HV-316 as
preferred leader. The HV-316 should already be
set to sync external. Here’'s the link again to
Audinate’s documentation on how to use Dante
Controller’s Clock Status window to do this:

https://dev.audinate.com/GA/dante-
controller/userguide/webhelp/content/clock syn

chronization.htm

LED Indicators

Millennia Media HV-316

Primary
v1 Multicast

Leader
Follower
Follower
Follower

- O
Primary Leader Clock: HV316-16-1fc438
Primary Secondary Secondary Preferred Enable Sync
v2 Multicast v1 Multicast  v2 Multicast Leader To External
Disabled Link dawn Link dawn O
MfA M/A NfA Follower Only  1/A

Solid green indicates which MADI input is
active, locked and in sync when not using
external Clock.

Flashing green - In the process of syncing and
locking to MADI input when not using external
Clock.

Solid yellow - indicates which MADI input is
active, locked and in sync when using external
Clock.

Alternating yellow/green - In the process of
syncing and locking to external Clock.

Flashing Yellow - Indicates external clock is
connected but no MADI input.

Clock Input - Uses word clock for external
synchronization. The system can run at sample
rates up to 192kHz when using an external
clock. You must use Dante Controller to set the
HV-316 to match it.

MADI XMT (Transmit) Out and RCV
(Receive) In - Multi-mode optical fiber with an
SC-Plug (IEC 874-19) or 75 ohm coax with a
BNC connector.

The optical connectors are under the removable
black protective cover. Outputs (XMT, Transmit)
are on the left, inputs (RCV, Receive) on the
right.

Optical and coax XMT (Transmit) and RCV
(Receive) can be connected simultaneously. The
system will automatically switch between
whichever RCV (Receive) input is actively
carrying data. XMT (Transmit) outputs are
always active

Clocking and Sample Rate - The MADI-2
board defaults to 48kHz when there is no MADI
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input connected. For other sample rates, you
must use Dante Controller to set the HV-316 to
match it.

MADI Channel Counts are reduced by half
when running at 96kHz sample rates and one
quarter at 192kHz. Be sure to take this into
account when planning your system capacity.

MADI Throughput Delay - Latency is three
samples per MADI card at 48kHz, 6 samples at
96kHz and 12 samples at 192kHz (the amount
of time is the same for all).

A 64-channel system would have 21 samples
between channel 1 and 64. Take this into
account when using stereo mics. Keep them in
the same preamp if possible.

MADI Channel Assignment -Ch 1-16 is the
unit with its transmitter (output) closest to the
mixer. 17-32 would be the next etc. If you are
using the 8-channel version of the HV-316, it
would be 1-8, 9-16 etc.
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Appendix

Flogic Keyboard Shortcuts

| Keys | Function

| Alt Click-and-Drag fader of linked group | Allows you to trim member of group
| Alt E | Edit Menu

| Alt F | File Menu

| Alt F4 | Close program

| Alt'S | Setup Menu

| |

Click and Drag on Link Matrix

Drag across to link/unlink channels

Click and Drag POL or Pad or 48V or Mute
or Split or Safe or RBIN or HPF or Link

Drag across channel buttons to select or unselect

Click and Drag Scene name

Drag to new place in list

| |

| Ctrl H | Help Menu

| Ctrl I | Unit identity check

| Ctrl L | Brings up Link Matrix
| Ctrl M | Meter preferences

| Ctrl N | Create new project

| Ctrl O | Open project

| ctrl S | Save

| Ctrl Z | Undo (10 levels)

| |

Double Click Group Title in Link Matrix

Lists channels that are members of the group

Double Click on unit icon in Unit Status box

Gives voltage, temperature and network data of
unit.

Double Click Scene name

Loads Scene

F1 Help Menu
Left/Right keys (on controls) Move channels one over
Right Click Group title name in Link Matrix Edit name

Right Click link box in Link Matrix

Edit channel name

Edit channel name

Right Click on meter

Edit meter settings

Right Click on unit name above faders

Edit unit name

Right Click scene name

Edit scene name

Shift Ctrl S

Save as

|
|
|
|
|
| Right Click on channel name below fader
|
|
|
|
|

Up/Down keys (on controls)

Increment/Decrement gain by 1dB

Microphone input wiring diagram - DB-25 to XLR Female AES59/Tascam Format

Channel| 1 | 2 | 3 | 4 | 5 | 6 | K
l+Pins | 24 |10 |21 | 7 | 18 | 4 | |1
-Pins |12 | 23 | 9 |20 | 6 | 17 | | 14
Gnd ‘25‘11‘22‘8‘19‘5‘ ‘2
Pins

Millennia Media HV-316
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MIDI Cable Wiring Diagram

The HV-316 MIDI port is a PS/2 style 6 pin mini-DIN. It
is wired the same as the Yamaha ZP893500 MIDI
Breakout Cable.

HV316 (male) MIDI OUT (female) MIDIIN (female)

MIDI Controller Table

X=MIDI Channel

| CC Hex | Function | Values (Hex)
X2h Pad 00h = OFF
7Fh = ON
X4h Phantom 00h = OFF
7Fh = ON
X5h Phase 00h = OFF
7Fh = ON
X6h High Pass Filter | 00h = OFF
7Fh = ON
X7h Mute 00h = OFF
7Fh = ON
| X9h | Gain | See Gain Table
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MIDI Gain Table

Decimal | Pro Tools dB | HV316 dB

|

0 | 0 | 1
| 1 | 3 | 1
| 2 | 6 | 1
| 3 | 9 | 1
| 4 | 12 | 1
| 5 | 15 | 15
| 6 | 18 | 18
| 7 | 21 | 21
| 8 | 24 | 24
I 9 I 27 | 27
.10 | 30 | 30
11 | 33 | 33
12 | 36 | 36
| 13 | 39 | 39
| 14 | 42 | 42
| 15 | 45 | 45
| 16 | 48 | 48
17 | 51 | 51
.18 | 54 | 54
L 19 | 57 | 57
|20 I 60 | 60
|21 | 63 | 63
| 22 | 66 | 64
.23 | 69 | 64
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Specifications

Minimum Gain

Maximum Gain (1 dB per step)

Attenuator Pad

Frequency Response (analog output option) (+0 / -3 dB)
Noise (60 dB Gain, 10 Hz - 30 kHz, Inputs common)

Total Harmonic Distortion + Noise (35 dB Gain, 10 Hz - 20 kHz
bandwidth, 0 dBFS Out
Intermodulation Distortion (50 Hz & 7 kHz), 35 dB Gain, 0 dBFS

Phase Response (35 dB Gain, 50 Hz - 20 kHz bandwidth, 0 dBFS

Common Mode Rejection Ratio (35 dB Gain, 10 Hz - 20 kHz
bandwidth, 100 mV C.M.)
Slew Rate (35 dB Gain)

Maximum Input Level (20 Hz - 40 kHz)

Maximum Output Level (20 Hz - 40 kHz) (analog output option)
Phantom Input Impedance (1 kHz)

Output Impedance

Phantom Powering

Power Consumption

Dimensions/Shipping Weight

DANTE

Physical Layer
Connectors

Cable Quality
Transmission Speed
Supported Sample Rates
Minimum Dante Latency
Supported Modes
AES67 Support

Certifications

Compliance

Environmental

Millennia Media HV-316

1dB

64 dB

-20 dB

sub 3 Hz to beyond 300 kHz
-130 dB EIN

< .005%, Typ.

< .0009%
< 2 degrees deviation
> 65 dB, Typ > 85 dB

> 25 Volts per microsecond

+34 dBu (pad in)

+22 dBu (analog option)

6,750 ohms

24.3 Ohms (analog option)

+48 V dc, +/- 2 V dc, 15 ma per channel

100 watts maximum
AC: Universal 90-240V, 50/60 Hz
DC: 12V

19" W x 1.75" H x 16" D, 10 Ibs (16ch), 9 Ibs (8ch)

Ethernet
Dual R3J-45
CAT-5e or better

1Gbps

44.1kHz, 48kHz, 88.2kHz, 96kHz, 176.4kHz,
192kHz

250 ps
Redundant / Switched

Planned

FCC CFR 47 Part 15 Subpart B, Class A
ICES-03 Issue 6 (Canada)

ANSI C63.4-2014

CE (EN55022 / EN55024)
RoHS 2002/95/EC

WEEE 2012/19/EU
REACH

-10° to +65°C / +15° to +150°F
10% to 80% Relative Humidity

Millennia Media reserves the right to change specifications, delivery, and pricing without notice.
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Architects and Engineers Specification

The Dante/AES67 interface will have 16 balanced mic/line
inputs available on DB-25 connectors.

The mic/line inputs for each channel will support up to 64dB
of digitally-controlled gain in 1dB increments.

Each input will have phantom powering available.

Each input will provide a selectable DC-coupled “ribbon mic”
path.

A DIN-type hardware MIDI control input will be provided.

A switchable attenuator will provide support for signal levels
up to +34dBu, when activated.

The front panel will include a power switch, along with display
that will show power active, aux power active, network unit
number, and LED status for each channel’s phantom, signal
present, and overload.

All mic/line input channels will have optional analog output
channels in addition to Dante output.

The device will support multiple digital-audio sample rates,

namely 44.1kHz, 48kHz, 88.2kHz, 96kHz, 176.4kHz, and
192kHz.

World Wide Warranty

The device will have a 16-position rotary switch to select its
network ID number.

The device will have a reset button to restore all settings to
factory default.

The Dante interface will support a switched or redundant
network mode.

The device will have two integrated Gigabit Ethernet ports on
RJ-45 connectors.

The device will support Ethernet and power redundancy.

The device will operate from either 12 VDC power or 80-264
VAC power, 47 to 63 Hz.

All parameter settings shall be non-volatile and self-restoring
in the event of a power interruption.

The device will be compliant with FCC CFR47 Part 15 Class A,
ICES-03 Issue 6, ANSI 63.4-2014, CE EN55022 Class A and
EN 55024 Class A, RoHS 2002/95/EC, WEEE 2012/19/EU, and
REACH.

The device will be accompanied by Windows-based control
software called ALogic, offering visual access to hardware
control, functionality, and scene management.

The device shall be the Millennia HV-316.

We will repair our products, free of charge, in the event of defect of materials or workmanship for two (2) years following date of

purchase.

This limited warranty covers failures due only to defects in materials and workmanship which occur during normal, intended use and
does not cover damage which occurs in shipment or failures which are caused by products not supplied by Millennia Media.

This limited warranty does not cover failures which arise from accident, misuse, abuse, neglect, mishandling, misapplication, faulty
installation, improper adjustment, alteration or modification of product, incompatibilities, line-power surges, lightning strikes, acts of
God, or service performed by anyone other than Millennia Media or its authorized agent.

Limits and Exclusions — There are no express warranties except as listed above. Millennia shall not be liable for special, subsequent,
incidental, consequential, or punitive damages, including, but not limited to: damage to recordings, broadcasts, microphones, mixing
consoles, or any associated equipment, downtime costs, loss of goodwill, or claims of any party dealing with purchaser for such
damages resulting from the use of this product. All warranties express and implied, including the warranties of merchantability and
fitness for a particular purpose are limited to the applicable warranty period set forth above.

Vacuum tube and bulb failures are not covered under warranty. Shipping costs to/from factory are not covered under this warranty.
International warranty law may vary from country to country, and Millennia will abide by the law of each country from which the

product was initially sold.

For North American repairs and service, contact Millennia (tech@mil-media.com) to obtain a Return Authorization number. Please
include your shipping address, daytime phone number and description of the problem. Outside of North America, please contact your

local Millennia Distributor.

Discarding Units

In the event that any Millennia equipment manufactured after July 1, 2006 needs to be discarded, you must return it to Millennia, at
our headquarters in California, USA. Please contact the distributor in your country or Millennia directly for instructions. We will make
arrangements to have the equipment shipped to us at no cost to you, and we will dispose of it in a manner that complies with

whatever regulations are in existence at that time.
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Millennia

Music & Media Systems

Millennia Media, SPC
6411 Capitol Avenue
Diamond Springs, CA 95619 USA

TEL: 001-530-647-0750
Y |

EU DECLARATION OF CONFORMITY

Brand: Millennia

Equipment Type: Commercial Audio Microphone Preamplifier
Family Name: HV-3

Model Name: HV-316 including all variants

We, Millennia Media, declare under our sole responsibility that the product,
to which this declaration relates, is in conformity with the following
standards.

Applicable Standards

Directive
Low Voltage Directive 2014/35/EU ~ EN 60065
EMC Directive 2014/30/EU EN 55032:2015 EN 55035:2017

EN 61000-3-2:2014 EN 61000-3-3:2013
RoHS: 2011/65/EU (and delegated Refer to Statement found at: https://www.mil-media.com/community.html
directive (EU) 2015/863)

And therefore complies with the essential requirements and provisions of
the applicable directives. The technical documentation is kept at Millennia
corporate headquarters, noted above.

Manufacturer: Millennia Media, SPC (a California Special Purpose
Corporation)

. ——
Signed: %C%ﬁm Date: 5 April 2021

Name afd Title: John La Grou, President

Declaration Number: V057394
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